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Touchpad PLUS Ver 2.2

 Data Storage and Memory

Let’s Plug-in  (Page no. 7)

   

Test Your Skills

1.	 a. (iii)	 b. (i)	 c. (ii)	 d. (iii)	 e. (i)

2.	 a. USB	 b. Byte	 c. Optical disc	 d. Zettabyte

3.	 a. Primary memory is the main memory of a computer.

	 b. �The  basic unit for  measuring the memory of a computer is a byte. A byte consists of a group 
of eight bits.

	 c. ��RAM is a temporary memory. The information stored in this memory is lost when the computer 
is turned off, whereas information stored in ROM is permanent in nature.

	 d. Blu-ray disc is an optical disc.  It is used for storing a large amount of data and playing videos.

4.	 a. He can use external hard disk to do so.

	 b. �The problem is with RAM because it only remembers things while the computer is on. To fix 
this, your friend should save the work on the computer’s hard drive before turning it off.

Tech Zone

Let's Solve

	 a. 1. 	 b. 4	 c. 3	 d. 2

1.
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Let’s Explore

Do it yourself.

 Managing Files and Folders in Windows 10

Let’s Plug-in  (Page no. 15)

1.	 This PC	 2. Folder	 3. Start Button	 4. Recycle Button

Let’s Catch Up  (Page no. 19)
	 1. b.	 2. c.	 3. a.	 4. d.

Test Your Skills

1.	 a. (ii) 	 b. (i) 	 c. (iii) 	 d. (i) 

2.	 a. Live	 b. This PC	 c. Two	 d. Thumbnail

3.	 a. (F)	 b. (T)	 c. (T)	 d. (T)

4.	 a. Excel file	 b. PowerPoint file	 c. Music file	 d. Video file

5.	 a. �The Start menu has two panes. The left pane displays an alphabetical list of all the programs 
installed on your computer. The right pane contains tiles.

	 b. �Pinning an application to the taskbar helps you to access that application easily.
	 c. �Recycle bin is a location where the deleted files and folders are stored before they are removed 

permanently.
	 d. To create a folder on the desktop, follow the given steps: 
	 Step 1: 	 Right-click at a blank spot on the desktop. A pop-up menu appears. 
	 Step 2: 	 Move the mouse pointer to the New option. A submenu appears.
	 Step 3: 	� Click on the Folder option. A new folder icon with the name New Folder appears 

on the desktop.
	 e. �A file is a collection of data and information, stored on a storage device. Whereas a collection 

of related files is called a folder. 
6.	 a. To move a file or folder, follow the given steps: 
	 Step 1:	 Open the folder containing the file you want to move. 
	 Step 2:	 Select the file or the folder to be moved. 
	 Step 3:	 Click on Home tab. 
	 Step 4:	 Click on Cut command in the Clipboard group. 

2.
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	 Step 5:	 Open the new location where you want to paste your file. 
	 	 Step 6: Click on Paste command in the Clipboard group. 
		  The file or folder is moved to the new location. 
	 b. �Taskbar is a long horizontal bar located at the bottom of the desktop. It helps to manage 

various currently active programs, opened in different windows. You can easily switch between 
these programs by selecting their icons on the Taskbar. It also has the Start button, Search 
box Quick launch bar, Clock, etc.

Tech Zone

Let's Solve

	 a. Win key + E	 b. Alt + P	 c. Alt + Shift + P	 d. Select file/folder+F2
	 e. Ctrl + C and Ctrl + V	 f. Ctrl + X and Ctrl + V

Let’s Explore

Do it yourself.

Periodic Assessment–1
(Based on chapters 1 & 2)

A.	 1. MEMORY	 2. FOLDER	 3. FILE EXPLORER	 4. MEMORY CARD
	 5. RECYCLE BIN	 6. RESTORE	 7. HARD DISK	 8. LIVE TILES	 9. FILE

B.	 1. Recycle Bin	 2. Music file	 3. Word File	 4. RAM

	 5. Folder Icon	 6. ROM	 7. Memory Card

C.	 1. File	 2. Start Menu	 3. File Explorer	 4. Recycle Bin	 5. Folder

	More on MS Word 2016

Let’s Plug-in  (Page no. 29)

Do it yourself.

Let’s Catch Up  (Page no. 37)

1.	 a. (ii) 	 b. (iii) 	 c. (iv) 	 d. (i)

3.
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Test Your Skills
 

1.	 a. (ii)	 b. (iii) 	 c. (i) 	 d. (iii)	 e. (ii) 

2.	 a. Columns	 b. Pictures	 c. Insert	 d.  Merging cells

3.	 a. (T)	 b. (T)	 c. (T)	 d. (F)	 e. (F)

4.	 a. �A table is an arrangement of data in vertical columns and horizontal rows forming a cell where 
they join together. Tables can be inserted using the Graphic Grid method or the Insert table 
command.

	 b. �Word 2016 has a set of built-in shapes that you can use in your documents. You can resize, 
rotate, flip, and add colour in shapes. The Shapes command contains several categories 
of shapes, like Lines, Rectangles, Basic Shapes, Block Arrows, Flowchart, Stars and Banners, 
and Callouts. 

	 c. To insert online pictures, follow these steps:

	 Step 1: 	 Click on Insert tab. 

	 Step 2: 	 Click on the Online Pictures option. 

	 Step 3:	 The Insert Pictures dialog box appears. Type a word in Bing Image Search box. 

	 Step 4:	 The Online Pictures dialog box appears. Select the picture, you want to insert. 

	 Step 5:	� Click on the Insert button. 

	 d. �WordArt is the special effect in Word to change the appearance of the text. You can create 
shadowed, skewed and stretched text that has been fitted to shapes. WordArt allows you 
to create text effects that are not available through font formatting. 

5.	 a. �To insert and format the table, follow the given steps: 

	 Step 1:	 Click on Insert tab. 

	 Step 2:	 Click on Table drop-down arrow in Tables group. 

	 Step 3:	 Click on Insert Table option. The Insert Table dialog box appears. 

	 Step 4:	 Enter the Number of columns: 3 and Number of rows: 5. 

	 Step 5:	 Click the OK button. The table appears in the document. 

	 To format the table:

	 •  Click inside the table to open the Table Design and Layout tabs.

	 •  In the Table Design tab, apply styles, borders, shading, and colours.

	 • � In the Layout tab, adjust row height, column width, alignment, or use Merge/Split Cells 
as needed.

	 b. Shapes command under Insert tab.
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Tech Zone

Let's Solve

	 a. Shape	 b. Format	 c. Shape Outline	 d. Theme Colors

Let’s Explore

Do it yourself.

	PowerPoint 2016

Let’s Plug-in  (Page no. 44)

Do it yourself

Let’s Catch Up  (Page no. 46)

	 1. Maximize	 2. Placeholder 	 3. Speaker’s notes Pane

	 4. Ribbon	 5. Status bar

Test Your Skills

1.	 a. (i) 	 b. (iii) 	 c. (ii) 	 d. (ii) 	 e. (ii)
2.	 a. Backstage	 b. Title bar	 c. Slide show	 d. Slide area

3.	
a. i.	  Reading view

b. ii.	 Slide Show

c. iii.	 Normal view

d. iv.	 Slide Sorter view

e. v.	 Outline view button

4.



6 Touchpad PLUS (Version 2.2)-IV (Answer Key)

4.	 a. (F)	 b. (T)	 c. (F)	  d. (F)	 e. (F)
5.	 a.	�A single page of the presentation is called a slide.

	     �Whenever you start presentation, the first slide which opens up is a Title slide by default. A 
title slide displays the text placeholder, where the text is to be typed.

	 b. �A placeholder is a dotted box on a slide which may contain text, pictures, video, etc. You can 
enter text in the placeholder by clicking on the title text placeholder box.

	 c.	� Slide layout is the formatting and positioning of the placeholder boxes for the content that 
appears on a slide. There are 9 types of slide layouts available in PowerPoint.

	 d.	�The slide sorter view shows the miniature version of all slides. Here, we can easily change 
the order of the slides. We can see slides on the screen, whereas Reading view is used when 
you want to view a presentation not in full screen but in a window with simple controls that 
make the presentation easy to review. The slides/outline pane are not visible.

6.	 a. To insert a picture from a file, follow the given steps: 
	 Step 1:	 Click on the Insert tab. 

	 Step 2: 	 Click on the Pictures option. 

	 Step 3:	 Browse the location where you have saved your picture file. 

	 Step 4:	 Select the desired picture file. 

	 Step 5:	 Click Insert button. 

	 b. �You can also insert a new slide by right clicking in the Slides Pane. Select New Slide option 
from the pop-up menu.

Tech Zone

Let's Solve

	 a. SLIDE	 b. PRESENTATION	 c. BACKSTAGE 	 d. PLACEHOLDER

	 e. POWERPOINT

Let’s Explore

Do it yourself. 

Let’s Get Better

Do it yourself.
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Periodic Assessment–2
(Based on chapters 3 & 4)

A.	 1. Glow		  2. Reflection

B.	 January February March
April May June
July August September

October November December

Row

Column Cell

C.	 Title Bar

Status Bar Speaker’s Notes Pane Placeholder

Ribbon

Slides/Outline 
Pane

Tabs

Quick Access Toolbar Control buttons

D.	 1. (F)	 2. (T)	 3. (T)	 4. (F)

Test Sheet–1
(Based on chapters 1 to 4)

Section A

A.	 1. (iii)	 2. (i)	 3. (ii)	 4. (iii) 

	 5. (ii) 	 6. (iii)	 7. (i)	 8. (iii)

B.	 1. Magnetic disk	 2. Column	 3. Status bar 	 4. Down	 5. Pictures

	 6. Slide area

C.	 1. (T)	 2. (T)	 3. (T)	 4. (F)	 5. (F)

D.	 1. (v)	 2. (iv)	 3. (i)	 4. (ii)	 5. (iii)
Section B

A.	 1. A collection of files is known as a folder.



8 Touchpad PLUS (Version 2.2)-IV (Answer Key)

	 2. All the files and folders that we delete are moved to the Recycle Bin.

	 3. WordArt option is present in the Insert tab.

	 4. Intersection of a row and a column is called Cell.

	 5. A single page of the presentation is called a slide.

	 6. A placeholder is a dotted box on a slide which may contain text, pictures, video, etc.
B.	 1. To rename a folder, follow the given steps: 

	 Step 1: 	 Select the folder to be renamed. 

	 Step 2: 	 Click on Home tab. 

	 Step 3: 	 Click on the Rename command in the Organize group. 

	 Step 4: 	� The name of the folder gets highlighted. Type the new name and press the  
Enter key. 

	 2. �WordArt is the special effect in Word to change the appearance of the text. You can create 
shadowed, skewed and stretched text that has been fitted to shapes.

	 3. To change the row height, follow the given steps:

	 Step 1: 	 Select the row or number of rows.

	 Step 2: 	 Click on Layout tab under Table Tools.

	 Step 3: 	� Change the height of row or rows in Height Scroll box.

	 4. �Computer’s memory is measured in terms of bytes. 1 byte is equal to 8 bits. There are other 
units like, kilobyte, megabyte, gigabyte, terabyte, etc.

	 5. �The slide sorter view shows the miniature version of all slides. Here, we can easily change 
the order of the slides. We can see slides on the screen, whereas Reading view is used when 
you want to view a presentation not in full screen but in a window with simple controls that 
make the presentation easy to review. The slides/outline pane are not visible.

	 6. �Slide layout is the formatting and positioning of the placeholder boxes for the content that 
appears on a slide. There are 9 types of slide layouts available in PowerPoint.

	More about the Internet
Let’s Plug-in  (Page no. 64)

Do it yourself

Let’s Catch Up  (Page no. 66)

Do it yourself

5.
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Test Your Skills

1.	 a. (i) 	 b. (ii) 	 c. (iii) 	 d. (ii)	 e. (iii)

2.	 a. Internet	 b. WWW	 c. Home page

	 d. Refresh	 e. Web browser
3.	 a. (T)	 b. (F)	 c. (F)	 d. (T)	 e. (F)

4.	 a. �Search Engine is a web tool which allows user to search or look up for desired information 
on the Internet. Some of the popular search engines are Yahoo, Google, Microsoft Bing, etc. 

	 b. �ISP is a company that provides you the Internet connection and services for an annual or monthly 
fee. Some popular ISPs in India are BSNL, MTNL, Airtel, Reliance Communications, etc.

	 c. �A Web page is the basic unit of every website. A web page may contain text, images, 
photographs, sound or video. 

	    �Whereas, a website is a collection of linked web pages. The first page of a website, which is 
displayed by default, is called the Home page. There are millions of websites that contain 
many web pages.   

	 d. �Microsoft Edge is the default web browser in the Windows 10  operating system. The three 
parts of Microsoft Edge are Current Tab, Back/forward, New tab.

5.	 a. To use a search engine, follow these steps: 

	 Step 1:	 Open a web browser. 

	 Step 2:	 Open a search engine, and type www.google.com in the address bar. 

	 Step 3:	� In the search box, type the keyword related to the information you are looking for. 
For example, type “Different types of birds”. 

	 Step 4:	 Press Enter key or click Search button. A list of related websites will be displayed. 

	 Step 5:	 Click on the link you find most relevant and read the information. 

	 b. �The URL or the web addresses of websites start with http://. The address of some websites 
such as a bank, e-commerce, etc. start with https://. Here ‘s’ stands for secure which means 
the website is secured for browsing.

Tech Zone

Let's Solve

	 a. ARPANET        b. MICROSOFT EDGE        c. HYPERLINK        d. INTERNET

	 e. SEARCH ENGINE
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Let’s Explore

Do it yourself.

Let’s Get Better

Do it yourself.

	Visual Processing

Let’s Plug-in  (Page no. 74)

4

6 3 1

7 5 2

Let’s Catch Up  (Page no. 76)

Do it yourself

6.
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Let’s Catch Up  (Page no. 78)

Cat
Stones

CloudTreeMoon

A3 A2 B3

A1 C1

Test Your Skills

1.	 a. (i) 	 b. (ii) 	 c. (i) 	 d. (i)

2.	 a.	

	 b.	

	 c.	

	 d.	
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3.	 Do it yourself.

4.	 a. Do it yourself.

	 b. Do it yourself.

Tech Zone

Let's Solve

Hall

Entrance

Kitchen

Bedroom

Periodic Assessment–3
(Based on chapters 5 & 6) 

A.	 1. World Wide Web refers to the largest collection of information available over the Internet.

	 2. A Web page is the basic unit of every website.

	 3. �Getting the data from the host computer (server) to the client computer (user’s computer) 
is known as downloading. 

	 4. �ISP is a company that provides you the Internet connection and services for an annual or 
monthly fee.

B.	

Apple DustbinBush

B2 B3 A2
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	More Blocks in Scratch

Let’s Plug-in  (Page no. 83)







 

 

 

Let’s Catch Up  (Page no. 86)

5

3

4

1

2

Test Your Skills

1.	 a. (i) 	 b. (ii) 	 c. (i) 	 d. (iii) 

2.	 a. Say	 b. Go to	 c. Sound	 d. Move

3.	 a. Turns the sprite clockwise by 15 degrees.

	 b. Used to set the volume of the sprite.

	 c. Used to say something for a given time.

	 d. Used to repeat a set of blocks for fixed number of times.

7.
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4.	 a. (T)	 b. (T)	 c. (T)	 d. (F)

5.	 a. �Say block

	 b. �The blocks that are used to control the movement of a Sprite are known as Motion blocks. 
These are blue in colour. 

	 c. �Wait block stops all activities for a given amount of time. You can use this block when two 
move or speak blocks are coming one after the other.

	 d. �Control blocks are looping blocks which are used when the same blocks have to be repeated 
for a number of times. Repeat block and Forever block are two types of control blocks.

6.	 a. �Use different costumes for each emotion. Add them in the Costumes tab, then use the “switch 
costume to” block from the Looks category to change appearance during the project.

	 b. �Meera should use the “go to x: 240 y: -180” block from the Motion category to move the 
sprite to the bottom right corner.

Tech Zone

Let's Solve
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Let’s Explore

Do it yourself. 

Let’s Get Better

Do it yourself.

	Creating Shapes in Scratch

Let’s Plug-in  (Page no. 92)

Do it yourself

8.
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Let’s Catch Up  (Page no. 95)

	 1. Heptagon	 2. Triangle	 3. Pentagon

	 4. Nonagon	 5. Hexagon	 6. Octagon

Test Your Skills

1.	 a. (ii) 	 b. (ii) 	 c. (i) 

2.	 a. Polygon	 b. 360	 c. Go	 d. Hexagon

3.	 a. (F)	 b. (F)	 c. (T)	 d. (T)

4.	 a. �The pen blocks draw a trail as the Sprite moves on the stage. The Pen blocks are green in 
colour. In Scratch 3.0, you have to add Pen blocks to the block category. 

	 b.  

	 c. �Polygons are 2D shapes with 3 or more straight lines and angles. Examples are Triangle, 
Square and Rectangle.

	 d. �To draw a square we can keep the value of the move block same but to draw a rectangle 
there will be 2 different values for the move block since there are two different values for 
sides of rectangle i.e length and breadth.

5.	 a. For a heptagon:

	     360 ÷ 7 = approximately 51.43 degrees

	     So, Rahul should turn the sprite 51.43 degrees after drawing each side.

	 b. She used the wrong angle.

	     A pentagon needs an exterior angle of 72 degrees (360 ÷ 5).

	     She has not repeated the drawing 5 times.

Tech Zone
 

Let's Solve

	 a. 0 sides, 360 degree	 b. 3 sides, 120 degree	 c. 4 sides, 90 degree
 	 d. 4 sides, 90 degree	 e. 5 sides, 72 degree	 f. 6 sides, 60 degree
	 g. 7 sides, 51.4 degree
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Let’s Explore

Do it yourself.  
Let’s Get Better

Do it yourself.

	Evolution of AI

Let’s Plug-in  (Page no. 101)

Do it yourself

Let’s Catch Up  (Page no. 106)
1.	 Ichiro Kato

2.	 ASIMO

Test Your Skills

1.	 a. (i)	 b. (iii)	 c. (iii)	 d. (ii)

2.	 a. v.	 b. i.	 c. ii.	 d. iii.	 e. iv.

3.	 a. F	 b. T	 c. F	 d. F

4.	 a. Artificial Intelligence is the ability of a machine to think and learn.

	 b. Alan Turing created Bombe, a machine that could decode the encoded messages.

	 c. �In 2016, David Hanson created a humanoid named Sophia. She can copy human gestures 
and facial expressions.

	 d. �In 2002, i-Robot released Roomba, an autonomous robot vacuum cleaner that cleans and is     
able to avoid crashing into obstacles.

5.	 a. �I would recommend a robotic vacuum cleaner like Roomba. It cleans automatically, so my 
mother doesn’t need to bend or move, which helps with her knee injury.

	 b. �Yes, my father can use a self-driving car. It helps him travel safely without driving, supports 
his mobility, and improves his independence and quality of life.

Tech Zone
 

9.
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Let's Solve

	 a.	 ALAN TURING	 b. WABOT	 c. ROOMBA	 d. SOPHIA	 e. SIRI

Let’s Explore

Do it yourself. 

Periodic Assessment–4
(Based on chapters 7 to 9)

A.	 Do it yourself. 

B.	 1. (iii)	 2. (i)	 3. (v)	 4. (ii)	 5. (iv)

Test Sheet–2
(Based on chapters 5 to 9)

Section A
A.	 1. (i)	 2. (i)	 3. (i)	 4. (i)	 5. (i)

	 6. (iii)	 7. (iii)	 8. (i)	 9. (ii)	 10. (i)

B.	 1. John McCarthy	 2. Polygons	 3. 360	 4. ISP	 5. Bombe

C.	 1. (F)	 2. (T)	 3. (F)	 4. (F)	 5. (F)

D.	 1. (iii)	 2. (i)	 3. (v)	 4. (iv)	 5. (ii)

Section B
A.	 1. Internet Service Provider

	 2. Artificial Intelligence is the ability of a machine to think and learn

	 3. Alan Turing created Bombe, a machine that could decode the encoded messages.

	 4. The four main directions are— North, East, West and South.

	 5. Control

	 6. The pen blocks draw a trail as the Sprite moves on the stage. 

B.	 1. �To draw a square we can keep the value of the move block same but to draw a rectangle 
there will be 2 different values for the move block since there are two different values for 
sides of rectangle i.e length and breadth.

	 2. �Wait block pauses the running of the script for the number of seconds given in the block. 
You can use this block when two move or speak blocks are coming one after the other. 

	 3. �A Web page is the basic unit of every website. 
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	     A web page may contain text, images, photographs, sound or video. 

	     A website is a collection of linked web pages.

	     �The first page of a website, which is displayed by default, is called the Home page. There are 
millions of websites that contain many web pages.

	 4. �The first chatbot ELIZA was created in MIT Artificial Intelligence Laboratory by Joseph 
Weizenbaum, in 1966.

	 5. �Control blocks are looping blocks which are used when the same blocks have to be repeated 
for a number of times. Repeat block and Forever block are two types of control blocks.

	 6. �Microsoft Edge is the default web browser in the Windows 10 operating system. The three 
parts of Microsoft Edge are Current Tab, Back/forward, New tab.


